ONLINE MAPPING SERVICES
USER’S GUIDE

FEBRUARY 10, 2017
NEW MEXICO STATE LAND OFFICE
310 Old Santa Fe Trail, Santa Fe, NM 87501

Table of Contents
Online Map Layout .................................................................................................................................................... 2
Basic Map Functionality ............................................................................................................................................ 3
Navigation tools ..................................................................................................................................................... 3
Basemaps ............................................................................................................................................................... 3
Scale bar ................................................................................................................................................................. 3
Overview Map ........................................................................................................................................................ 4
Pan ......................................................................................................................................................................... 4
Identify Features .................................................................................................................................................... 4
Locate a Place or Address ...................................................................................................................................... 5
Tools and Layers ........................................................................................................................................................ 6
Legend .................................................................................................................................................................... 6
Layers ..................................................................................................................................................................... 7
Search..................................................................................................................................................................... 8
Bookmarks ........................................................................................................................................................... 10
Identify ................................................................................................................................................................. 10
Draw ..................................................................................................................................................................... 11
Measure (Area, Distance, and Location).............................................................................................................. 12
Print a Map........................................................................................................................................................... 14
MAP_ONLY ....................................................................................................................................................... 17

1

Online Map Layout
All mapping services contain similar layouts and functionalities. The figure below shows the basic design of the
New Mexico State Land Office online mapping services.
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The online maps are comprised of a main map frame that displays the various data layers, a tool panel located to
the left of the map frame, and a results table that appears in the bottom panel when a query or search is
performed.
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Basic Map Functionality
When the map is initiated, it appears with the full extent of the state of New Mexico.
Navigation tools are located within the upper-left corner of the map frame:
Zoom in or out. The mouse wheel will also zoom in and out. Place the cursor over the area to be zoomed
to and roll the wheel forward to zoom in. Roll the mouse wheel backward to zoom out.

Return to default extent (state of New Mexico).

Track physical location of the user. The device’s GPS or GeoIP address is used to show the user location.

Basemaps: Select a map or imagery as a background. Click the Basemaps button located in the upper-right corner
of the map frame, and a list of options appears. Select from topographic, shaded relief, street maps, or satellite
imagery.

Scale bar: The scale bar is located on the lower-left corner of the map frame and has units of both miles and
kilometers. The scale bar dynamically changes as the map extent changes (zoom in or out).
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Overview Map: The arrow located on the bottom-right corner of the map frame activates the map overview. Click
on the arrow to see where the current extent of the map frame falls within a larger map. Click the downwardfacing arrow to close the overview map.

close overview map

Pan: Place the cursor in the map frame, hold down the left mouse button, and drag the mouse.

Identify Features: Place the cursor over a feature in the map and click the left mouse button. A dialog box will
appear with attribute information for each feature under the cursor. To view attributes for different features,
click the Next Feature arrow to scroll through information for all overlapping features.
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Locate a Place or Address: The map contains a geocoder to quickly locate and zoom to a specified area. The
geocoder is located in the title bar above the map.

Enter an address, a city/state, or a landmark then click on
or press the Enter key and the map zooms to the
location. As the location is being typed, a drop-down list appears below the text box. If the list contains the place
of interest, click on the list item and the map will zoom to the location.
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Tools and Layers
The left panel of the web map contains various tools for searching, viewing layers, identifying specific layers,
drawing shapes, measuring distance or area, and printing maps.

Legend
The map service opens with the legend as expanded. The symbology is viewed as it would be seen on a printed
map. To collapse the legend, click on the Legend bar.

6

Layers
Data layers can be viewed and manipulated within the map to change the order or physical appearance. Expand
the Layers section in the left panel. The various layers for the map service are listed.

Expand the
symbol next to the layer to view the layer’s symbology. These correspond to the same symbols in
the Legend section.

Check or uncheck the box next to the layer name to turn on or off a layer within the map. The Legend section
will be updated as layers are checked or unchecked.
Click on the layer menu icon located to the right of a layer group. This opens a menu with tools to further
manipulate the layers within the group.
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The layer group can be repositioned to change the drawing order in the map by moving the layers up or down
within the legend. The transparency can also be changed. This will change the transparency level for all layers
with the group.

Search
Click on Search to expand the search options. The different maps will have a unique set of parameters to search.
Under Select Search Type: is a drop-down menu that shows the different layers available for searching.

Select the layer to search and enter the search value in the Search for: text box. Click on the Find exact matches
only check box to locate those records with the exact value entered in the text box. If the box is left unchecked
and a partial value is entered, a set of values will appear. Select a value in the Results window to complete the
search query.

A complete search string can also be entered. After clicking the Search button, click on the returned value in the
Results window, and the map will zoom to the selected feature. The selected feature will be highlighted in red.
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The bottom panel will open containing tables of other features that intersect the selected feature.

Click on the links above the table to view the intersecting features from different layers. Click on a record in the
table, and the map will zoom to the feature. The selected feature will be highlighted in blue.

Click on the Export button located above the table and to the right. A dialog box appears with a drop-down menu
to select a format for the exported file. The choices are either a MS Excel spreadsheet or a comma separated
values (CSV) file. The browser will provide a choice to open or save the file.
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To collapse the table, click the down-arrow

above the panel.

Bookmarks
The Bookmarks tool allows you to store a map extent so you can quickly return to the area. Go to the area of
interest within the map. Expand the Bookmarks tool. Click Add Bookmark. Enter a descriptive name in the
textbox. The map extent is stored within the bookmark.

To return to the area of interest at a later time, simply click on the bookmark name.
Click on

to edit the bookmark’s name. Click on

to delete the bookmark.

Identify
To identify objects, place the cursor over an object and click the left mouse button. A dialog box appears. As
described on page 4, the dialog box provides attributes for every feature that intersected the cursor. To limit the
attribute list to a specific layer, open the Identify tool. The tool populates with the names of the visible layers
within the map extent.
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The tool defaults to All Visible Layers. To see only attributes for a specific layer, click on the layer name in the pulldown menu. In the map frame, click on a feature from that layer. The dialog box will only show attributes from
the selected layer, even if there are overlapping features from other layers.

Draw
To draw shapes or place points in the map frame, expand the Draw tool. There are several options for adding
shapes to the map.
Point
Circle
Straight Line
Freehand Line
Polygon (angled)
Freehand Polygon
Clear Drawing

For points, straight lines, and angled polygons, click the left mouse button in the map at the starting point of the
shape, then move to the next point and click. Click the left mouse button for each vertex of a line or polygon.
Double-click the left mouse button when the shape is completed.
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For freehand shapes, press the left mouse button to begin drawing. Without releasing the mouse button, move
the cursor over the map. Release the mouse button when the shape is completed.

Measure (Area, Distance, and Location)
Length and area can be measured within the map frame. Expand the Measurement tool. Three icons appear.
Area
Distance
Location
Click on an icon, and the measurement units appear. Click on the units and a drop-down menu appears containing
a list of units to choose from.
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Using the left mouse button, click the starting point in the map. For area measurements, continue to click each
vertex until the point of beginning is reached. Double-click the mouse button when finished. The Measurement
Result section displays the area or length measurement in the selected units.

For measuring distances between two locations, click on the Distance icon, select the units of measure, click the
first location, then click the second location. The distance between locations is listed in the Measurement Result.
Curved distances can be measured by clicking several vertices to approximate a curve. Green markers are placed
at each vertex. Double-click when finished.

The Location icon provides latitude and longitude coordinates for a location in the map frame corresponding to
where the cursor is located. Click on the icon and the units of measure appears. The drop-down menu lists either
decimal degrees or degrees-minutes-seconds (DMS). Place the cursor in the map frame and the positional
coordinates are listed in the Measurement Result section. Click in the map frame and a green marker will be
placed on the map with the coordinates shown in the results.
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Print a Map
The Print tool can produce a digital static map of a desired area. Zoom to the area of interest and check the layers
that will appear in the map. Expand the Print tool.

Enter a title for the map in the Title textbox. Expand the Format pull-down menu and select a file format for your
map. There are a variety of image formats to choose from. The format defaults to pdf.

Expand the Layout pull-down menu to select a page size and orientation for the map. .

Click the Settings button, and a dialog box appears containing various map settings. Enter the appropriate settings
to control the appearance and digital quality of the map. You can choose to include a legend, the units for the
scale bar, the print resolution (DPI), whether to preserve the map extent (print only the area visible in the
browser), or preserve the scale (add to or remove area to fit on the selected page).
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pixels

When all settings, format, and layout have been selected, click the Print button. A link to the map appears below
the settings.

Link to digital map

Click on the link to view the map.
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There can be multiple map links corresponding to different maps located within the Print tool. The links will be
available until the Clear Print History button is clicked or the browser is closed.

Note: The legend will contain all data layers that are visible, regardless if they appear within the map extent. To
control the items in the legend, uncheck those data layers in the Layers section that do not appear in the map
extent (see page 7). This will shorten the legend contents. The legend is vertically centered. As the number of
items increases, the legend will expand up and down.
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MAP_ONLY
The MAP_ONLY option in the Layout menu produces a digital map with nothing surrounding the layout, i.e., no
legend, title, scale bar, or annotation. The entire page is filled with the map. The Width and Height dimensions
in the Settings menu are only activated when the MAP_ONLY option is used and are in units of pixels.
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